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Chapter 1 - Introduction to the
program

Introduction to the program

The LIQUITER program determines the safety factors pertaining to the liquefaction of incoherent saturated
terrains subjected to earthquake phenomena.

The method of calculation used (Seed and Idriss) requires one to know a few commonly used geotechnical
parameters and the seismic parameters necessary to simulate the cyclical stress induced by the earthquake.
The verification is based on the resistance factor to liquefaction calculated as the ratio between the limit shear
stress that induces liquefaction and the maximum shear stress induced by the quake, apart from the interstitial
pressures and deformations developed during the very earthquake.

The limit stress and maximum stress are rendered adimensional through the ratio between cyclical stress
obtained by normalising the amplitude of the shear force with the effective initial vertical pressure G; in
accordance with the formula:

F = (T/le)lim

t/o,
There are several methods to determine the resistance to liquefaction based on the study of the behaviour of
samples during laboratory test or based on in situ test at the sites that have given rise to liquefaction. In each of
the two cases correlations have been proposed between the resistance to liquefaction and geotechnical and
seismic parameters of the site. The parameter that in literature presents most correlations and comparisons is
the number of blows of the SPT test.
The formula used enables one to take into account the occasional character of maximum acceleration peaks
through the ratio of cyclical stress induced by the earthquake with reference to an average value t,, = 0.651

instead of the maximum valuet,

max

Hence the resistance factor to liquefaction is given by
F — (T/Gv)lim

TaV/GV
where
Tav

* = 0.65(a,,/g)r, (5,/0,)
(e}

v

The resistance to liquefaction is valued as a function of the magnitude, the number of blows, the effective
vertical pressure and the relative density using the correlations between the ratio of cyclical stress and the
number of observed blows in terrains that gave rise to liquefaction phenomena and non-liquefaction during real
earthquakes.

In the chart, derived in this way, the lines relative to earthquakes of a given magnitude separates those ranges
of sites with probable liquefaction from those where this is improbable.

During the calculation phase the program evaluates, for each SPT test made, the corrected number of blows in
such a way as to consider the lithostatic pressure. This correction is made by using a correction coefficient
calculated as a function of the depth where the test takes place and the relative density. The corrected number
of blows enables one to evaluate, for a given magnitude, the ratio between cyclical stress that causes
liquefaction, if the resistance factor to liquefaction F is larger than 1.3 the terrain is considered to be non-
liquefiable.
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Chapter 2 - System requirements
and program installation

System requirements

e Pentium® class processor

e Microsoft® Windows® 95 OSR 2.0, Windows 98, Windows Me, Windows NT®* 4.0 with Service Pack 5 or
6, Windows 2000, or Windows XP

e 64 MB of RAM (128 MB recommended)
¢ 100 MB of available hard-disk space
e CD-ROM drive

e A printer driver must be installed, even if the printer itself is not connected to the PC.

Program Installation

To install LIQUITER run the liquiter32setup.exe installation package from the CD-ROM or from the download
directory.

Winip Self-Extractor - liquiterd2setup.exe

h Prezs SETUP ta start installation

Cancel

Il

About

Press the Setup button...

LIQUITERSZ Setup

Choosze the installation directory:

S e
[ My Documents
B Program Files
LIWINDDWS

Do you have an hardware protection key?

@ Mo, | am running a demo yersion.
@ Yes, | have a parallel key.
® ‘rez. | have a USB key.

[l Restore the default configuration of columns, logo and textures.
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...and select the directory to create the LIQUITER32 folder.
Click the Continue button and the program program is automatically installed.

The first time you run the program the window that allows you to select your preferred language appears.
Simply click on the flag of the language you prefer.

Select your language. ..
BN BN =5

The language selection will be saved in the “LANGUAGE.CFG” file, which is found in the program directory. To
select another language, it is sufficient to exit the program and delete this file. The language selection window is
shown once more at the next run of the program.
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Chapter 3 - The program
protection

Hardware protection key

This section should instead be carefully read if the program was bought through the Internet.

Hardware protection key - Parallel port

Plug the hardware protection key that is supplied with the program into the parallel port connector of your PC.
The hardware key should be plugged directly into the PC, before any other device, to avoid hardware conflict
with other keys.

The printer cable can then be connected to the hardware protection key, as it does not interfere with the printing
operation. If the hardware key has not been correctly installed, the program will start in demo mode.

For further information about the hardware key, please visit the Web site http://www.eutron.com

Windows 95, Windows 98 and Windows Me
Windows 95, Windows 98 and Windows Me automatically recognize the hardware key, so no other operation is
required.

Windows NT, Windows 2000 and Windows XP
Windows NT, Windows 2000 and Windows XP require the installation of a software driver to enable access to
the hardware key. To install the software driver, follow this procedure:

1. start Windows, and login as Administrator
2. install the package

3. browse the program directory, and run the program SKEYADD.EXE in the folder
HardKeyDrivers\Parallel_NT-2000-XP

4. restart the computer
To uninstall the software driver, follow this procedure:
1. start Windows, and login as Administrator

2. browse the program directory, and run the program SKEYRM.EXE in the folder
HardKeyDrivers\Parallel_NT-2000-XP

3. restart the computer

Hardware protection key - USB port

Plug the hardware protection key, supplied with the program, into one of the USB connectors of your PC.

For further information about the hardware key, please visit the Web site http://www.eutron.com

Windows 95, Windows 98, Windows Me, Windows 2000 and Windows XP
All Windows versions, except Windows NT, automatically recognize the PnP hardware key, and require the path
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to load the driver from. To install the driver, follow this procedure:
1. start Windows, and login as Administrator (if necessary)
2. install the package
3. browse the program directory, and select the folder HardKeyDrivers\ USB_9x-Me-2000-XP

Windows NT

Windows NT requires the installation of a software driver to enable the access to the hardware key. To install
the software driver, follow this procedure:

1. start Windows, and login as Administrator
2. install the package

3. browse the program directory, and run the program SKEYUSBADD.EXE in the folder
HardKeyDrivers\USB_NT4

4. restart the computer
To uninstall the software driver, follow this procedure:
1. start Windows, and login as Administrator

2. browse the program directory, and run the program SKEYUSBRM.EXE in the folder
HardKeyDrivers\USB_NT4

3. restart the computer
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Chapter 4 - Using the program in a
local network

Using the program in a local network

The programs can be used in a local network without moving the hardware key from one computer to another.
It is also possible to purchase multiple licenses to use the program on several computers at once.

The computer to which the hardware key is physically connected is defined as the “Server”, and the computer
that requests the authorisation to run in fully operational mode from to the Server is defined as the “Client”.
The program must be installed on the Server (with the proper hardware key drivers if necessary), and on each

Client (in demo mode).
The program keyserver.exe should also be installed on the Server. The installation file of this program can be

found on the distribution CD-ROM, or on the Internet, at the URL:
http://www.geoandsoft.com/download/KeyServerSetup.exe

Run keyserver.exe and the hardware key management window appears.

w, keyserver | | =]

I Local Host IP: 195.89.152.1 Create Program Configuration Files |

Click the “Create Program Configuration File” button, and browse your network to select the executable file you
want to remotely activate (for example \\computerO3\c\program files\liquiter32\liquiter32.exe). Now, with the
keyserver.exe program running, liquiter32.exe can also be run from the PC “computer03”.

NOTE: the contemporary use of the program on more then one computer is allowed only if a multiple
license has been purchased.
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Chapter 5 - General information

Usage Notations

Some typographical notations and keyboard formats are used in this manual to help locate and interpret
information more easily.

Bold print is used to indicate command names and related options. Characters appearing in bold print should
be typed exactly as printed, including spaces.

Words written in italics indicate a request for information.
CAPITAL letters are used to indicate computer, printer, directory, and file names.

Keyboard formats are used as follows:

e KEY1+KEY2 - indicates press and hold down key1 and then, at the same time, press key2. For example,
alt+c means one should press and hold the alt key down and, at the same time, press the c key. The keys
are always indicated with capital letters.

o key1,key2 - A comma (,) between key names means that the keys must be pressed in sequence. For
example, ALT,C means one should press and release the ALT key and then press and release the C key.

Because of the differences in keyboard layouts, the names of the keys on the keyboard may not correspond
with those described in this manual. The word ARROW (LEFT, UP, RIGHT, DOWN) indicates the use of the arrow
keys.
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Chapter 6 - User Interface

User Interface and Data Entering

The user interface is designed to be easy to use and powerful and is supported by complete on-line help. This
help contains practical hints and the theoretical background, where applicable. It should reduce the requirement
of frequently consulting the printed manuals.

All the commands are located inside a menu bar. Each menu contains a list of commands that one can select
with the mouse or the keyboard. The arrangement of the menus, designed with ergonomic criteria, follows the
logical order of the operations, inhibiting the access to further operations until all the necessary data have been
entered.

The interface layout is maintained in all of our programs, to simplify, as much as possible, the transition from
one program to another to avoid having to learn different commands and procedures for similar functions (such
as entering data or managing files).

Let us examine the general components that are available in the user interface of geo&soft programs.

User Interface: Menu Bar and Menus

The Menu Bar manages the access to all the program commands. The goal of the menu design is to offer an
ergonomic, simple, and understandable arrangement of the commands.

The menus used to perform a complete operation are normally ordered left to right and top to bottom. When
possible, the following scheme is used: definition of the name of the project, entering the required data,
performing the calculation, and generating the output as a preview or final print.

LIIJUITEFI 32 M= B
| Files Edit Print Exit Help

Open
Save
Erinter Setup
Help

The programs automatically disable some menus or commands when the execution of such menus or
commands is not yet feasible. Typical examples are: a calculation menu is disabled when not all the data
needed for the calculation have been completely entered, or a print menu is disabled if not all the calculations
have been executed.

To choose a command from a menu, use the following procedures:

B Point the menu that is to be activated, click the left button of the mouse, then point the command to be
activated, and click the left button of the mouse again. If one does not wish to select any command
from the menu that is open, exit the area of the menu before releasing the mouse button.

Press the ALT key to activate the menu bar. Press, on the keyboard, the underlined character in the
menu name or press ENTER or the DOWN arrow, to select the first menu. Press on the keyboard the
underlined character in the menu name or select it using the arrow key and then press ENTER, to
execute a command in the selected menu. Press ESC to close the menus without executing any
command.

The Graphical Output Preview Window

The Toolbar is located in the upper side of the preview window.
The Toolbar allows fast access to the commands with the mouse. Click the corresponding icon, to select one of
the commands that belong to the Toolbar. The Toolbar displays the following commands:
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Zoom + : clicking the first icon activates the ZOOM function (it can only be used with the mouse) that
permits the enlargement of part of the drawing. The function remains active until the Zoom - icon is selected.
To enlarge a part of the drawing:

click the icon, and then select the area to be enlarged by clicking the upper-left corner and dragging
the mouse pointer to the lower-right corner. At this point, release the mouse button. Note: due to the
low resolution of the screen, the texts could appear in a slightly different scale at different zoom levels.
This does not affect the quality of the final printouts.

Zoom - : click this icon to return to the original scale of the preview.
Arrows: click the arrow icons, in "Zoom + " mode, to pan the on-screen preview.
Print: click the print icon to send the drawing to the default printer.

Resized print: click this icon to send the drawing to the default printer. The image will be resized to fit the
current paper size.

DXF: one can export the graphic output as a DXF file by clicking this icon; it gives access to a dialogue
window that enables one to assign a different name to the DXF file, which has, by default, the same name
as the current project.

EMF/W: This icon allows the graphic output to be exported to a version of the Enhanced Windows Metafile
which is compatible with Microsoft Word. Clicking this icon gives access to a dialogue window that enables
one to assign a different name to the EMF file, which has, by default, the same name as the current project.

EMF/D: This icon allows the graphic output to be exported to a version of the Enhanced Windows Metafile
which is compatible with Corel Draw. Clicking this icon gives access to a dialogue window that enables one
to assign a different name to the EMF file, which has, by default, the same name as the current project.

Exit: click this icon to close the preview window and return to the main menu.

The Input Dialogue Windows

The different menu commands can perform an immediate action, or display a dialogue window in order to input
or edit the various data sets.

When a dialogue window is visible, all the actions that do not pertain to it are ignored. Hence, it is necessary to
close the dialogue window to resume the normal use of the program.

FARAMETERS OF CALCULATION |

Load [kM] .o |0
Whidth ] 1]
Lenath [m] o 1]
Depth watertable [m] ... 1]
flagnitide [-] ..o 1]
bl aw. Acceleration [mAs] 1]

ok | Cancel | Help |

I\/ertical lnad applied to the foundation, enter O if abzent.

Some fundamental tools are used inside the dialogue windows: data fields such as text and list boxes, and
buttons.

The text boxes are used to input numerical values and text strings. Most of the editing keys (HOME, END, INS,
DEL, etc.) can be used inside these fields. If one sees a small arrow pointing down on the right side of the data
field, one has a list box.

To scroll the list box and select an item, do as follows:
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‘B click the arrow, and then click the item to be selected.

press the DOWN arrow until one arrives at the item to be selected. It is also possible to press a letter to
directly reach the first item that begins with that letter.
Tere are three buttons in the dialogue window:

e <QOk> - this button saves the entered information and goes on to the next phase.

e <Cancel> - this button closes the Dialogue window without saving the just entered data, or without
executing the command.

e <Help> - this opens a window that contains general information on how to use the dialogue windows.

To use the buttons:
B click the button

press alt+underlined letter
To edit the data inside the dialogue window, use the following keys:

e TAB - moves the cursor to the next field; when the cursor is inside the last visible field the cursor goes to the
first control button of the Dialogue window. To return to the previous field, press SHIFT+TAB.

e ENTER - moves the cursor to the next field. If the cursor is positioned on one of the window buttons, the
corresponding command is executed.

e BACKSPACE - cancels the last character that has been entered.
e DEL - cancels the character to the right of the cursor.

e ESC - closes the Dialogue window without saving the entered values or without executing the command. The
<Cancel> button will do the same.

e UP ARROW/ DOWN ARROW - these are used in multiple fields, or those fields that have a list box.
e LEFT ARROW/ RIGHT ARROW - moves the cursor to the previous or next field.
e HOME -moves the cursor to the beginning of the field.

e END - moves the cursor to the end of the field.

A yellow box with a short text that explains the meaning of the value to be entered, can be seen in the lower part
of the window. If the text is not completely visible, click the yellow box to read the complete text.

Data Input With Tables

Tables are used to enter long sequences of numerical values and/or text strings. The keys to be used are the
following:

e TAB - moves the cursor to the first button in the window. When one presses this key again, the cursor is
moved to the next button.

e SHIFT+TAB - moves the cursor to the previous button.

e ENTER - moves the cursor into the next input field. If the cursor is positioned on one of the window buttons,
the corresponding command is executed.

e PAGE UP - moves the cursor up 15 lines.

e PAGE DOWN - moves the cursor forward 15 lines.

e UP ARROW - moves the cursor to the input field directly above.

e DOWN ARROW - moves the cursor to the input field directly below.

e LEFT ARROW / RIGHT ARROW - moves the cursor to the field respectively to the left or to the right of the current
position.

e HOME - moves the cursor to the beginning of the line.
e END - moves the cursor to the end of the line.

e F2 - copies the field contents to the extended editing field under the title bar in order to facilitate the editing
of the long strings. When working in this editing field, please REMEMBER to press ENTER, even before
clicking the <Ok> button. Double-clicking a field has the same effect as pressing the F2 key.
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GEOTECHNICAL PARAMETERS OF THE STRATIGRAPHY |

N.| Depth [m]] Gn [kNAe]| Ga [MAne]| Bd [%]] D50 [mm]] = |

15 j

Drepth from ground level to the bottomn of the stratum.

ok | Cancel | Inzert | Delete | Help |

The tables have two additional buttons:

e <Insert> - creates an empty line before the one in which the cursor is positioned.

o <Delete> - deletes the line in which the cursor is positioned.

IMPORTANT SUGGESTION: you can copy data to or from other programs such as Microsoft Excel:
The data entered in the table can be copied in order to be pasted into another table.

To copy the table’s contents:

press the key combination CTRL+C. The contents will be copied into the Clipboard of Windows.
To paste the Clipboard contents into the table:

press the key combination SHIFT+INS, or CTRL+V.
A yellow box with a short text that explains the meaning of the value to be entered, can be seen in the lower part
of the window. If the text is not completely visible, click the yellow box to read the complete text.

Message Windows

The function of these windows is to give information to the user concerning the system status, as in the case of
an error due to an improper use of the program.

WARNING!

[t iz not pozzible to edit data before having opened a file.

Help On Line

A complete Help On Line is available. It is possible to ask for information or suggestions related to the
commands or the use of the program. In order to access the help on line, proceed as follows:

1. Position the cursor on a field of a dialogue window and press F1.

2. Use the Summary from the Help menu.
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Chapter 7 - Commands

Files Menu (ALT,F)

This menu contains the commands for opening and saving files. In these all the information relative to the
project is stored. Until a name is given to the work the program will not permit the use of other menus.

AMLIQUITER 32 =] 3

|Files Edit Print Exit Help

Open

Save

Erinter Setup
Help

New Command (ALT,F,N)
To open a new file:

B from the menu choose New by first clicking on the name of the menu then on the New command.

from the File menu choose New by using the combination of the keys ALT,F,N.

Open Command (ALT,F,0)

To be able to work with the program one should, first of all, create a new file or open a pre-existing file.
To open a file:

B from the menu choose Open by first clicking on the name of the menu then on the Open command. In
the File Name field type the name of the file to be opened or, if the file already exists, double click on
the name of the desired document which can be found in the list underneath the File Name field.

from the File menu choose Open by using the combination of the keys ALT,F,0. In the File Name cell,
type the name of the file to be opened or, if the file already exists, press TAB and then the UP ARROW or
DOWN ARROW to select the name from the list underneath the File Name field and press ENTER.

The name of the file being used is reported inside the title bar of the main window and inside a window referable
by selecting the Help menu.

The name of the file should not contain spaces and/or punctuation marks. It is not necessary to indicate
extensions, since the extension “.LQT” is added automatically: for example, the given name “TEST” will have
the file name “TEST1.LQT"

Save Command (ALT,F,S)

During the work session the program uses a copy of the file which is temporarily loaded into the computer’s
RAM. To save work on the hard disk it is necessary to use the Save command; otherwise all the data introduced
will be lost when one exits from the program. If an electrical problem or any other type of problem interrupts the
computer’s functioning all the data not yet saved will be lost, so it is advisable to save the work often.

To save a file:

B select Save from the file menu by clicking first on the name of the menu and then on the Save
command. In the File Name field, the name given to the file when it was originally opened appears. To
confirm that name click on the <Ok> button. To assign a new name to the file, type the new name in
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this field.

select Save from the File menu by using the key combination ALT,F,S. To confirm the name given to
the file when it was opened press ENTER. To assign a new name, type the name in the File Name field
and press ENTER.

The program will save the file in the current disk unit and directory unless specified otherwise. To save the file
on a different disk unit or in a different directory, type the full path in the File Name field. For example, to save
the document in the root of disk C: type c:\filename or select a different unit or directory.

Printer Setup Command (ALT,F,C)

By selecting this command one goes to “Print” dialog box. Here one can verify and modify the Default printer’s
Setup or select another printer from those installed one ones system.
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Edit Menu (ALT,E)

Through this menu one can enter the data necessary for a calculation.

AMLIQUITER 32 Mi=] E3

Files | Edit Print Ezit Help

Ol Stratigraphy ;PT a5 Ab @

2 Mept
Parameters
Titlez

Help

i
o

Stratigraphy Command (ALT,E,S)

The command enables one to introduce the geotechnical parameters of the lithotype, that can be vertically
inhomogeneous.

The "Geotechnical parameters of the stratigraphy"” Dialogue Box
The window shows a table where the following values have to be entered.

GEOTECHNMICAL PABAMETERS OF THE STRATIGRAPHY |

Depth [m]| Gn [kM/re]| Gs [kNAe]] Bd [%Z]] D50 [mm]] « |

—_ =
e

_| ==
= | L3 | D

5
L

Depth from ground level to the baottom of the stratum.

(1] | Cancel | Ingert | Delete | Help |

e Depth of the bottom of the bed from the surface level;
e Specific weight, drained, of layer;

e Specific weight, saturated, of layer;

o Relative density

¢ Median diameter of particles
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NSpt Command (ALT,E,N)

Selecting this command the “Nspt values” dialogue window is shown, where one has to enter the depth at which
the test was performed as well as the NSPT value.

The the “Nspt values” Dialogue Box

The window shows a table where the following values have to be entered.

MSPT YALUES

N.| Depth [m]| Mspt []] « |

15 Ad

D epth from ground lewvel to the point whene the test iz
executed.

ok | Cancel | Irizert | Delete | Help |

o Depth: depth from ground level to the point where the test is executed.

e  Nspt: number of blows.

Parameters Command (ALT,E,P)

With this command it is possible to define the seismic parameters and eventual overloads due to the presence
of a structure.

The "Parameters of calculation” Dialogue Box
The window shows a table where the following values have to be entered.

FARAMETERS OF CALCULATION

Load [kM] .o |0
Whidth ] 1]
Lenath [m] o 1]
Depth watertable [m] ... 1]
flagnitide [-] ..o 1]
bl aw. Acceleration [mAs] 1]

ok Cancel Help

rertical lnad applied to the foundation, enter O if abzent.
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Load: the overload induced in the soil by the presence of a foundation of Width L and length H, that
transmits a total load Q, at the depth Z is given by the formula:

o Q
(L+2)*(H+2Z)

according to the simplified classical formulation it does not use the modulus of deformation of the material.

Width and Length of the foundation: area on which the load is distributed.

Depth of water table: while the program allows one to work with completely saturated terrains the program
allows to enter the depth of the water table in order to consider the strata above the water table as loads
exerted on the terrain below.

Magnitude

Maximum Acceleration

Titles Command (ALT,E,T)
To facilitate the reading of the drawings produced by the program a main title and five sub-titles are provided.

TITLE DEFINITION |

b ain tithe ..o |
First subetitle ...
Second subditle ...
Third sub-title ......................
Fourth zub-title ....................
Fifth sub-title ...

ok | Cancel | Help |

[t iz pozzible to enter up bo six titles, the firzt ane will be written with larger characters. Entering a title and
zubtitles iz ot required.
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Print Menu (ALT,P)

With this menu it is possible to produce graphic output or listings of all data by selecting from the following menu
titles: Graphics and Listings.

AMLIQUITER 32 Mi=] E3

Ol = E Graphics !% Ab %

Liztings  #
LCanfigure
Help

[

i
o

Graphics Command (ALT,P,G)

By selecting this command the program executes the calculations that have not yet been performed (note that
when modifications to the data have been made, the calculation of the new values is automatically provided)
then the drawing that.

Listings Command (ALT,P,L)
By selecting this command the program opens a sub-menu where one can select the preview mode, and wether
to print or export the listing.

Listings Preview Command (ALT,P,L,P)

With this command it is possible to preview the listings pertaining to the calculation result. The listing can not be
changed here.

To scroll the text use the scroll bars on the window or use the UP and DOWN arrow keys, or the PAGE UP e PAGE
DOWN. keys. To exit press ESC or double-click any point of the listing.

The file containing the listing is saved on disc in the same directory where the data files resides. It has the same
name with the difference of the ".TAB" extension. The file is in the normal ASCII format and its pagination is
such that all commands have the # sign as prefix.

Fast Print Listings Command (ALT,P,L,F)
With this command the listings pertaining to the calculation result are printed directly.

Export Listings in DOC Format (ALT,P,L,E)

With this command the listings pertaining to the calculation result are exported in the format used by Microsoft
Word 97.

The file will have the same name but with the ".DOC" extension and will be saved in the same directory where
the data files reside.

At the end of the file exportation this file will be visualised by invoking the Winword program.

Export Listings in TXT format (ALT,P,L,T)

With this command the listings pertaining to the calculation result are exported in the “Text only” format.

The file will have the same name but with the ".TXT extension and will be saved in the same directory where the
data files reside.

At the end of the file exportation this file will be visualised by invoking the Notepad program.

Listing Export to SLK (ALT,P,L,S)

With this command, it is possible to export the listings of the calculation results into the SLK format (Microsoft
Excel 97 compatible).

The program creates a file, with the same name as the current project but with the ".SLK" extension; the file is
saved in the same directory as the data files.
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The file is automatically opened if the program finds the Microsoft Excel executable.

Configure Command (ALT,P,C)
With this command, one can define the graphical properties of the different objects in the graphical output.

COLOUR SELECTION

i - Colours

et litles 1| O Not drawn
drawing frames

drawing axes

M zpt

cormected Mapt

total vertical tension
effec. vertical tension
zf<1

#f<1.3

sf¢=5 ) light gre
zfx5h

definition colour n. 1

defintion of calour n. 2 &

_ light green
(_ light cyan

Arial Black
Anal Marraws

AvantiG arde 1| O yellow

*) black

bargins (cm)

Left D Taop ||:| | ak. Cancel

0.1

Thickness (mm) |'

One can associate a colour, a line thickness and a character font to each object. Notice that not all the objects
have both a line thickness and a character font: for example, a fitle only requires the colour and the character
font to be defined.

Click an object to select it (use the scroll bar to see the entire list)

Click one of the option buttons, in the “colours” frame, to select the colour that has to be associated to the
selected object. The Not drawn option hides the object of the graphical output.

If the object contains texts, one can choose a character font from the list (use the scroll bar to see the entire
list)

If the object contains lines, one can assign a thickness to the lines (in mm). If the value is zero, the program
uses the thinnest line on the output device.

It is possible, as an option, to assign a left and a top margin (in cm) to the whole graphical output.

NOTE: although the available set is limited to fifteen colours, they can be manually customised; double-click the
coloured bar to open the Colour Dialogue Box and choose a different RGB value associated to the selected
colour.
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Exit menu (ALT,X)

This command allows one to exit the program. If the file being used contains modifications that have not yet
been saved the program will propose the file saving window, if you would like to save these modifications.
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